
 

 أعلى المستند

  Netbeansبرنامج مع  تجربتي
  .الجافا وتطبيقات برامج في برمجة وتصميم ويستخدم الجافا لغة محررات برامج أحد هو   NetBeans برنامج

 ئج طلاب في الامتحانعرض نتاي وهذا التطبيق له خياران أولهما جوالتطبيق طريقة صنع مختصر لعبارة عن شرح يب تّ الكُ  هذا
   .إيجاد العاملي لعدد ماالثاني يقوم ب و باستخدام المصفوفات

  ..فهذا ليس اختصاصي ...  والفائدة وقد قمت بكتابته ليس عن معرفة وعلم وإنما عن فضول وحب الاطلاع

  .مثل هكذا برامج بسيطة  وطبعاً جاء الفضول من البحث عن طريقة صنع تطبيقات الموبايل والفكرة من حاجة المدرسين إلى

  :في نهاية الكتاب يجب أن تكون قادراً على                              

 .إنشاء مشروع جديد باستخدام برنامج نتبينز  •

 .صناعة واجهة لتطبيق الجوال •

منها في صناعة  والاستفادة والمصفوفات استخدام الدوال •
 .تطبيق للجوال

 .وأزرار الاختيار فورماتوال التعامل مع الأزرار والعناصر •

  .إضافة أيقونة لتطبيق الجوال وإضافة تفاصيل أخرى  •

  طريق بيانات وحفظها عن إضافةالتي تمكننا من  RecordStoreبالاعتماد على خاصية  صنع التطبيقجربت  ::::في البداية في البداية في البداية في البداية 
  .اصية للغة العربيةي واجهت مشكلة في عدم دعم هذه الخنولكن...  Key , value  هب الخاصة والقيمة مفتاح

  .المصفوفات  هي بالاعتماد على فكرة قد تكون أكثر سهولة و فلجأت إلى

        .صورة التطبيق النھائية 



 

 أعلى المستند

  tips.org-http://java      موقع     :  المراجع 

  kutub.infoساعة من موقع  24كتاب تعلم لغة الجافا في  

لذلك أغلب المراجع ... دني في هذا الموضوع إلا أنني لم أجد بحثت كثيراً عن كتب باللغة العربية تفي 
  ...التي استفدت منها كانت تتحدث عن لغة الجافا الخاصة بالكمبيوتر وليس بالجوال 

        الفهرسالفهرسالفهرسالفهرس                                            

        ٣٣٣٣........................................................................................................................................................................................................................................................تنصيب البرنامج وإنشاء مشروعتنصيب البرنامج وإنشاء مشروعتنصيب البرنامج وإنشاء مشروعتنصيب البرنامج وإنشاء مشروع

        ٤٤٤٤................................................................................................................................................................................................................................................................................................................ق ق ق ق إنشاء واجهة التطبيإنشاء واجهة التطبيإنشاء واجهة التطبيإنشاء واجهة التطبي

        ٥٥٥٥....................................................................................................................................................................................................إضافة الفورم وأزرار التطبيق والروابط بين الأزرار إضافة الفورم وأزرار التطبيق والروابط بين الأزرار إضافة الفورم وأزرار التطبيق والروابط بين الأزرار إضافة الفورم وأزرار التطبيق والروابط بين الأزرار 

        ٦٦٦٦........................................................................................................................................................................................................................................................................إضافة حقل نصي وعنصر نصي إضافة حقل نصي وعنصر نصي إضافة حقل نصي وعنصر نصي إضافة حقل نصي وعنصر نصي 

        ٧٧٧٧................................................................................................................................................................................الاسم بالعلامة عن طريق المصفوفات الاسم بالعلامة عن طريق المصفوفات الاسم بالعلامة عن طريق المصفوفات الاسم بالعلامة عن طريق المصفوفات     إبدالإبدالإبدالإبدالكتابة دالة كتابة دالة كتابة دالة كتابة دالة 

        ١٠١٠١٠١٠........................................................................................................................................................................    و تمرير قيمة حقل الاسم لهاو تمرير قيمة حقل الاسم لهاو تمرير قيمة حقل الاسم لهاو تمرير قيمة حقل الاسم لها         search search search searchالدالة الدالة الدالة الدالة استدعاء استدعاء استدعاء استدعاء 

        ١١١١١١١١........................................................................................................................................................................................................................        التطبيق إلى الجوالالتطبيق إلى الجوالالتطبيق إلى الجوالالتطبيق إلى الجوال    إرسالإرسالإرسالإرسال    إضافة أيقونة وإضافة أيقونة وإضافة أيقونة وإضافة أيقونة و

        ١٣١٣١٣١٣................................................................................................................................................................................................................................................    تعلمّ كيفية التعامل مع أزرار الاختيارتعلمّ كيفية التعامل مع أزرار الاختيارتعلمّ كيفية التعامل مع أزرار الاختيارتعلمّ كيفية التعامل مع أزرار الاختيار

            ١٨١٨١٨١٨............................................................................................................................................................................................................................................................للتطبيقللتطبيقللتطبيقللتطبيقإضافة خيار إيجاد العاملي إضافة خيار إيجاد العاملي إضافة خيار إيجاد العاملي إضافة خيار إيجاد العاملي 
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برفع  التي تقوم الأخرىاحد المواقع  أو برنامج نتبينز من موقع جافا صن إلىتحتاج  ))))تنصيب البرنامجتنصيب البرنامجتنصيب البرنامجتنصيب البرنامج: (: (: (: (    الأولىالأولىالأولىالأولى    الخطوةالخطوةالخطوةالخطوة
  )ميغا بايت ٣٠٠تقريبا : حجم البرنامج ( .من أحد المواقع التعليمية المختصة بالبرمجة أو..  الملفات الكبيرة الحجم

  ....المحظور عنها موقع جافا صنسوريا في الحصول على البرنامج كوني من  فقد عانيت صعوبة:  ربتيوعن تج

   Java ME ثم اختر  بروجكت جديد  على زر ضغطوا:   بعد تنصيبه افتح البرنامج ))))إنشاء مشروعإنشاء مشروعإنشاء مشروعإنشاء مشروع((((    الخطوة الثانيةالخطوة الثانيةالخطوة الثانيةالخطوة الثانية

  

        

        

        

        

        

File > New Project > Java ME > Mobile Application > cliFile > New Project > Java ME > Mobile Application > cliFile > New Project > Java ME > Mobile Application > cliFile > New Project > Java ME > Mobile Application > click on Next buttonck on Next buttonck on Next buttonck on Next button                            
  

  

  

  

  

  

  قسم الجافا الخاص بالجوال 

 اسم المشروع

 مكان حفظ المشروع

 مجلد المشروع

تعيين المشروع كمشروع رئيسي 
  Runأي عند الضغط على ... 
المشروع الذي سيتم تنفيذه  فإن

  .هو مشروعنا

 ..قم بإلغاء التحديد هنا لأن لدينا مشروع خاص ولا نريد مشروع الترحيب 
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  :لتظهر الشاشة التالية                        ثم اضغط

  

  

  

  

         Finishثم ثم ثم ثم      Nextثم اضغط ثم اضغط ثم اضغط ثم اضغط 

  ......انتظر قليلاً حتى يتم إنشاء ملفات المشروع 

  : مرئية للتطبيقلإنشاء واجهة  اضغط الخيارات التالية ::::        ))))واجهة مرئية للتطبيقواجهة مرئية للتطبيقواجهة مرئية للتطبيقواجهة مرئية للتطبيقإنشاء إنشاء إنشاء إنشاء : (: (: (: (الخطوة الثالثةالخطوة الثالثةالخطوة الثالثةالخطوة الثالثة

  

Right click on default package > New > Visual MIDlet…Right click on default package > New > Visual MIDlet…Right click on default package > New > Visual MIDlet…Right click on default package > New > Visual MIDlet…    > rename it to Result > rename it to Result > rename it to Result > rename it to Result             
        

        

  
     Resultقم بتسميته 

صان محاكي هذان الخياران يخ
اتركهما على ،الجوال 

 .حالهما

اختيار هذا الخيار ضروري جداً لكي يعمل 
 التطبيق على الجوال بشكل صحيح

  Source Packagesتمُثل الـ 

 الذي المشروع كلاسات و نوافذ و ملفات

  . صنعه نود

هذان الخياران 
 للأجهزة القديمة
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        ))))والروابط بين الأزراروالروابط بين الأزراروالروابط بين الأزراروالروابط بين الأزرار    إضافة الفورم وأزرار التطبيقإضافة الفورم وأزرار التطبيقإضافة الفورم وأزرار التطبيقإضافة الفورم وأزرار التطبيق: (: (: (: (الخطوة الرابعةالخطوة الرابعةالخطوة الرابعةالخطوة الرابعة

                   Flowاضغط على نافذة  

 :و افلاته Displayablesقائمة سحب فورم من ثم قم ب

                                         

  

  

                                                                                              

  

على  والإفلاتوذلك عن طريق السحب   commandsمن قائمة )  okCommand , exitCommand( ثم قم بإضافة 
  :كالتالي  )أيضاً بالسحب والافلات( الأسهمواعمل  الفورم

  

 aml_987@hotmail.com   
  

  

  

  

  

  إضافة زر الموافقة و زر الخروج

هذا السهم يصل بين بداية التطبيق والفورم الذي 
 .قمنا بإنشائه

 ...زر الموافقة 

 زر الخروج

على كلاسات   Formتحتوي الـ 
ونستطيع ، بالإضافة إلى الواجهات 

 كالأزرار نريد ام فيه نضع أن 
  .الخ... النصوص وصناديق

 ..هذا السهم ليس ضروري 

 .ھذه بمثالة جھاز الجوال 
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        ))))حقل نصي لإدخال اسم الطالب وعنصر نصي لإخراج علامة الطالبحقل نصي لإدخال اسم الطالب وعنصر نصي لإخراج علامة الطالبحقل نصي لإدخال اسم الطالب وعنصر نصي لإخراج علامة الطالبحقل نصي لإدخال اسم الطالب وعنصر نصي لإخراج علامة الطالبإضافة إضافة إضافة إضافة : (: (: (: (الخطوة الخامسةالخطوة الخامسةالخطوة الخامسةالخطوة الخامسة

لذلك قٌم :   النتيجة لإظهار )String Item(ـ الاسم وبحاجة ل إدخال من أجل Itemsمن قائمة  )Text Field (ـبحاجة ل أيضاً نحن
  )  . Items(وهذه صورة قائمة الـ ....   الفورم لى ع بسحبهما بالفارة ثم قم بالإفلات

  

  aml_987@hotmail.com  
  

  

  

  

  

          أو  F6اضغط على زر       

  تظهر شاشة المحاكي التالية          Runعلى زر  اضغط

  : وتبين نتيجة الخطوات التي ذكرناها

  

  

  

  

 قائمة العناصر

من أجل إلى الفورم  اسحب هذا العنصر 
 .إظهار النتيجة فيه

  .لأننا لم نقم بعد بكتابة أي أمر لتنفيذه ، لن يحدث شيء  OKلاحظ أنه عند الضغط على 

  .والخطوات السابقة عبارة عن صنع واجهة البرنامج فقط 

اسحب هذا العنصر إلى الفورم من أجل 
 .سمإدراج حقل الا
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        ))))كتابة دالة ابدال الاسم بالعلامة عن طريق المصفوفاتكتابة دالة ابدال الاسم بالعلامة عن طريق المصفوفاتكتابة دالة ابدال الاسم بالعلامة عن طريق المصفوفاتكتابة دالة ابدال الاسم بالعلامة عن طريق المصفوفات: (: (: (: (الخطوة السادسةالخطوة السادسةالخطوة السادسةالخطوة السادسة

  :لذلك سأقوم بشرح بسيط لها ... تحتاج إلى معرفة بسيطة بالمصفوفات  هذه الخطوة 

  ;Type variable [] = New Type [size]                     : العامة الصيغة

  

  

  

  

  

  

  ،،، نحن سنستخدم الطريقة الأولى 

  .الأولى من نوع نصي للأسماء والثانية من نوع صحيح للعلامات: نحتاج إلى مصفوفتين 

  

       :                                                            الاسم بالنتيجةالاسم بالنتيجةالاسم بالنتيجةالاسم بالنتيجة    إبدالإبدالإبدالإبدالدالة دالة دالة دالة كتب لكي ت)  source(اذهب إلى نافذة الـ  :الآن 

  : search اسمالدالة بـ وقم بتسمية ... ها بعد  التالية  اكتب الدالةو  public Resultابحث عن جملة 

  

  

  

هناك طريقتين لإدخال عناصر 
  ...المصفوفة 

 محتوى إلى تاً مباشر قيمال إدخال الطريقة هذه وتمثل:  المباشرة   الطريقة

  كالتالي هي و ، المصفوفة

 Type variable[] = {… , … , … , … , …}; 

   أخر كائن من قيمة إدراج الغير مباشرة أو طريقةال

Type variable[] = New Type [size]; 
Variable [index] = value ; 
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  :وفيما يلي شرح كل جزء من أجزاء الدالة 

  

 

  

                                                                                              

                   

  

  

  

  

  .الأسماء والعلامات كما تشاءتغير طبعا أنت تستطيع أن *

 

  )ممتاز  –جيد  –ضعيف (ة البحث عن اسم طالب وكتابة الع"مة المقابلة  سمه وتقديره دال

لطالب أقل من إذا كانت ع�مة ا
  :نفذّ  12

وھي ، search: اسم الدالة 

  .  String: نوع الدالة  . Stringتُرجع قيمة من نوع 

مصفوفة أحادية  
تحتوي على أسماء 
الط�ب وھي من 

 . Stringنوع 

ھذه مصفوفة تحتوي على 
ع�مات الط�ب المقابلِة 
ل2سماء وھي من النوع 

  .الصحيح

طولھا من   forحلقة 

إذا كانت القيمة الممرة للدالة   .ول مصفوفة  ا4سماءط
مساوية 4حد ا4سماء في 

 :مصفوفة ا6سم نفذّ 

قم بإرجاع ع�مة 
 .الطالب المقابلة 6سمه 

تجدر ا;شارة بأنه 
من أجل مقارنة 
نصين في الجافا 
فإننا نستخدم ھذه 

 .الصيغة 

 :قم بإرجاع العبارة : في حال لم تجد ا6سم 
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 ملاحظة ملاحظة ملاحظة ملاحظة : تستطيع اجتياز هذه الصفحة لأنها ليست  أساسية في صنع التطبيق بل زيادة معلومات في الجافا ...

  .رقمية  الى نصيه من البيانات تحويل عند خدامهالاست الكلاسات أنواع و البيانات أنواع بين الفرق ::::الجدول الأول  الجدول الأول  الجدول الأول  الجدول الأول  

 

        

        

        

        ::::أنوع المتغيرات أنوع المتغيرات أنوع المتغيرات أنوع المتغيرات : : : :     الجدول الثانيالجدول الثانيالجدول الثانيالجدول الثاني

        

 

 

 

 

  الجدول الثالث الجدول الثالث الجدول الثالث الجدول الثالث : : : : المعاملات الحسابية المعاملات الحسابية المعاملات الحسابية المعاملات الحسابية ....

    

        

        

        
  .من موقع كتبمحمد الصيلمي لھذه الجداول ھو كتاب  مصدر
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        ))))و تمرير قيمة حقل الاسم لهاو تمرير قيمة حقل الاسم لهاو تمرير قيمة حقل الاسم لهاو تمرير قيمة حقل الاسم لها         search search search searchالدالة الدالة الدالة الدالة استدعاء استدعاء استدعاء استدعاء : (: (: (: (الخطوة السابعةالخطوة السابعةالخطوة السابعةالخطوة السابعة

        التاليين بعد السطر ثم قم بإضافة السطرين  Enterثم اضغط    commandActionواكتب ) يعني بحث(  F +Ctrlغط اض

} else if (command == okCommand) { :  

              aml_987@hotmail.com  
  

                 

        

        

        

  

  :  Runالآن اضغط ع زر و

  تكوينبناء التطبيق و من أجل هذا الزر أيضايفيد و فيه أخطاء تستطيع أن تجرب التطبيق وترى إن وجِدَ و والمحاكي الج سيظهر
  ) . Project Folder(  في مجلد البروجكت )   Jar File(ملف الجار

  : وهذه هي نافذة المحاكي 

  

  

  

  صورة ا4وامر التي سيتم تنفيذھا عند الضغط على زر الموافقة

    وإسنادوإسنادوإسنادوإسناد    Stringهو تعريف متغير من نوع هو تعريف متغير من نوع هو تعريف متغير من نوع هو تعريف متغير من نوع : : : : السطر الأول السطر الأول السطر الأول السطر الأول 
        .طبعاً الحقل الأول هو اسم الطالب    ....    ههههقيمة الحقل الأول لقيمة الحقل الأول لقيمة الحقل الأول لقيمة الحقل الأول ل

وتمرير قيمة وتمرير قيمة وتمرير قيمة وتمرير قيمة         searchهو استدعاء دالة هو استدعاء دالة هو استدعاء دالة هو استدعاء دالة : : : : ني ني ني ني السطر الثاالسطر الثاالسطر الثاالسطر الثا
الناتج  لـ  الناتج  لـ  الناتج  لـ  الناتج  لـ  كل كل كل كل     وإسنادوإسنادوإسنادوإسناد    إليهاإليهاإليهاإليها        nameeالمتغير المتغير المتغير المتغير 

stringItem     اد المظللة بالرمادي  تكون مكتوبة تلقائياً من قبل الأكوهذه  ....التي ستظهر بها نتيجة الطالب التي ستظهر بها نتيجة الطالب التي ستظهر بها نتيجة الطالب التي ستظهر بها نتيجة الطالب
إذا قام : " البرنامج ومعنى هذا الأمر باللغة العربية 

، " وافقة قم بتنفيذ الأوامر التاليةالمستخدم بضغط زر الم
 .ونحن سنقوم بإضافة بعض الأوامر هنا  

getString(); 

عبارة عن دالة  تحول القيمة الممرة إليها إلى قيمة نصية حتى ولو 
 .كانت القيمة الممررة هي قيمة صحيحة 

اكتب اسم الطالب هنا ثم 
 OKاضغط 

 .ستظهر النتيجة في هذا الحقل
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        ))))يقيقيقيقإضافة أيقونة وتفاصيل أخرى للتطبإضافة أيقونة وتفاصيل أخرى للتطبإضافة أيقونة وتفاصيل أخرى للتطبإضافة أيقونة وتفاصيل أخرى للتطب: (: (: (: (الخطوة الثامنةالخطوة الثامنةالخطوة الثامنةالخطوة الثامنة

ثم   X 64  64يكون قياسها  لى سطح المكتب ويجب أنعقم بحفظ الصورة التي تريدها  :للتطبيق  إيقونة إضافة ن أجلم
        :البرنامج مجلد اسحبها إلى 

aml_987@hotmail.com  
  

  

    :   sourceالـ الموجودة في أعلى                                  على القائمة التاليةاضغط  الآن

  :تظهر النافذة التالية  ثمالخطوة  ذه دور به ليس لها لان )Cancel( اضغط: نافذة  تظهربعدها 

                      :كما في الصورة    Application  Description الخيار الرابع  قم باختيار

  

  
  

  

  

  

  

 aml_987@hotmail.com  
  

  تعديل مسار أيقونة التطبيق  

 وفي حالتنا هذه هو أيقونةاسم التفصيل الذي تريد إضافته 

تعني أن مسار الأيقونة "  /" وإشارة  مسار أيقونة التطبيقهنا 
  .المشروع  سيتم إكماله تلقائياً مثل مسار

  png   ،Bmp: تخدام اللواحق تستطيع اس

  :فتظهر النافذة التالية   MIDlet-Icon ثم  …Add اضغط على 



 

 أعلى المستند

 .السطر الأول لتغيير اسم البرنامج

  السطر الثالث خاص بنسخة البرنامج

 .بالمبرمج  بإسم السطر الثاني خاص

      . OK اضغط  ثم

  : اذهب إلى هذه القائمة : مثل اسمه و نسخته والمطور و غيرها :  لإضافة تفاصيل أخرى للتطبيق

  

    

  

  

بالتعديل يفُترض أن تكون هذه الخطوة هي الأخيرة ولكني سأقوم     ))))ارسال التطبيق إلى الجوالارسال التطبيق إلى الجوالارسال التطبيق إلى الجوالارسال التطبيق إلى الجوال: (: (: (: (الخطوة التاسعةالخطوة التاسعةالخطوة التاسعةالخطوة التاسعة
  .على التطبيق لذلك قمت بإدراجها هنا 

و قم  distعلى جوالك تستطيع أن ترسله من مسار التطبيق في المستندات ثم اضغط على  مجلد  أردت تجربة التطبيقإذا  
  .اجهيحوي وصف للبرنامج وفقط الأجهزة القديمة تحت (JAD)ومن الجدير بالذكر  أن ملف الـ . بإرسال ملف الجار لجوالك 

  :dist\MobileApplicaDon7\NetBeansProjects\Documents\Aml\Users\C :فمثلا أنا لدي الملف على المسار 

        ::::جوالك لتجربته جوالك لتجربته جوالك لتجربته جوالك لتجربته قم بإرسال التطبيق إلى قم بإرسال التطبيق إلى قم بإرسال التطبيق إلى قم بإرسال التطبيق إلى : : : : الآن الآن الآن الآن 

  :ستظهر لك النتيجة التالية : م بتنصيبه بعدما تقوم بإرسال ملف الجار لجوالك و تقو

  

لاحظ وجود أيقونته  صنعناه هذا هو التطبيق الذي
 .بالشكل الصحيح



 

 أعلى المستند

  : لك الشاشة التالية  وعندما تفتح التطبيق من المفترض أن تظهر

  
  ))))تعلمّ كيفية التعامل مع أزرار الاختيار عن طريق إضافة شعبة الطالبتعلمّ كيفية التعامل مع أزرار الاختيار عن طريق إضافة شعبة الطالبتعلمّ كيفية التعامل مع أزرار الاختيار عن طريق إضافة شعبة الطالبتعلمّ كيفية التعامل مع أزرار الاختيار عن طريق إضافة شعبة الطالب: (: (: (: (الخطوة العاشرةالخطوة العاشرةالخطوة العاشرةالخطوة العاشرة

  ... أو رقمه أو صفهعبة الطالب ل ش تستطيع إضافة تصنيف للطلاب مثلاً مث::  أخرىأخرىأخرىأخرىأفكار أفكار أفكار أفكار         ومن الممكن إضافةومن الممكن إضافةومن الممكن إضافةومن الممكن إضافة

  جديدة )   Items( عناصرنضيف  يجب أن شعبة الطالب إضافة تنفيذ فكرة ومن أجل

  )   Choice Group , choose element     ٢عدد (       و هم

      

   الموجودة على يمين نافذة البرنامج Itemsوطبعا نقوم بسحب هذه العناصر من قائمة 

  .فورموإفلاتها على ال

ي ذكرناها قم بسحب العناصر التو :  Screenنافذة  لـ اذهب    ::::الآن الآن الآن الآن 
        .قليل قبل 

        

        

  قائمة العناصر

يجب تعديل : من أجل عدم السماح باختيار خيارين معا 
بالضغط عليه بالزر اليميني   choiceGroupخصائص الـ 

  . ثم اختر خصائص

وتستطيع تحديد عدد الأحرف المسموح بها نافذة : هذه عدد الأحرف المتبقية 
screen  :الموجودة طبعا بالنتبينز وليس بالجوال.  

  Maximum Size> خصائص > زر يمنين على حقل ا6سم والكنية 



 

 أعلى المستند

        

  

  

ذا هلديك  يل ليصبحتعدوقم بال commandAction    كتبثم ا  )F +Ctrl( على ثم اضغط   Sourceالآن اذهب إلى الـ 
  :الشكل 

  

                            

               aml_987@hotmail.com 

                           

  

  

  

ولصقها بعدها وقم  searchوذلك بنسخ دالة  searchقم بكتابتها بعد الدالة ...   search1هي كتابة الدالة  ::::الخطوة التالية الخطوة التالية الخطوة التالية الخطوة التالية 
  :فيصبح الشكل التالي : و إضافة الأسماء و العلامات التي تريدها   1بإضافة 

  

  Shift+Alt+F:  حدد الكود ثم اضغط على المفاتيح :لتنسيق كود ما     ملاحظةملاحظةملاحظةملاحظة

  ) ا4ولى والثانية(إضافة خيارات الشعبة 

  Exclusiveإلى      Typeقم بتغيير الـ 

إذا قام المستخدم باختيار الخيار الأول 
ومرر  searchقم باستدعاء الدالة : 

 nameeلها المتغير 

ار الخيار إذا قام المستخدم باختي
 search1قم باستدعاء الدالة : الثاني 

 namee ومرر لها المتغير

باقي الدالة هو نفسه موجود في 
  .الدالة الأولى

إذا كانت الواجهة الفعالة هي الواجهة   :نفذّ   okإذا ضغط المستخدم زر 
  :نفذّ  formذات الاسم 



 

 أعلى المستند

  F6أو على زر          Runالآن اضغط 

  

  :   واليصبح لدينا هذا الشكل في محاكي الج...  التسميات تغيير  وبعد

  

                                                                                                                                                                                                                                                                                                                aml_987@hotmail.com  
 

 

 

    : Exitو  OKيل نص الـأزرار مثل تبد من أجلو

 okCommandعلى  نيضغط زر يماو )Flow  (شاشة  اذهب إلى
   ☺إلى موافق  OKمن  Labelبعدها خصائص و قم بتغيير الـ 

aml_987@hotmail.com                    
                  aml_987@hotmail.com  

                  

  
  صورة البرنامج النھائي في محاكي الجوال

  تغيير اسم ا وكي كومنت وا كزت كومنت

  شاشة محاكي الجوال

 .نتائج الامتحان مثلاً : تستطيع تغيير اسمه بالضغط المزدوج عليه وتكتب : اسم الفورم 

 ) .الاسم(قم بتعديل اسم هذه الخانة بالضغط المزدوج واجعله 

 .كتابة اسم الطالب ذا حقل له

 )النتيجة : (لذلك قم بالتعديل لتصبح : هنا ستظهر النتيجة 

الشعبة الثانية : ولى الشعبة الأ: الشعبة : قم بالتعديل إلى : مجموعة الخيارات 
 .على الترتيب 

  :يوجد ملاحظة جديرة بالذكر هنا وهييوجد ملاحظة جديرة بالذكر هنا وهييوجد ملاحظة جديرة بالذكر هنا وهييوجد ملاحظة جديرة بالذكر هنا وهي

ه فإنه لن عندما تضغط بالفارة خارج الحقل بعد تبديل اسم
  .بعد كتابة الاسم   Enterأي أنك يجب أن تضغط ...يتغير



 

 أعلى المستند

  : لك الشاشة التالية  وعندما تفتح التطبيق من المفترض أن تظهر

  
  :من قائمة العناصر  صورةصورةصورةصورة    عنصرعنصرعنصرعنصرقم بسحب : أو لوغو صغير للبرنامج  لإضافة صورة

            . screenعلى نافذة  بإفلاتهوقم 

  

    

  .ثم قم بسحب الصورة التي تريدها و قم بافلاتها على العنصر المضاف          

  : العنصري على اضغط بالزر اليمين) يمين او يسار او بالوسط (أو عنصر ما ومن أجل تغيير موضع الصورة 

                                

  > اختر خصائص  ثم      

              

وتستطيع تحديد عدد ا4حرف المسموح : ھذه عدد ا4حرف المتبقية 
  .بالنتبينز وليس بالجوال الموجودة طبعا:  screenفيھا من نافذة 

  Maximum Size> خصائص > زر يمنين على حقل ا6سم والكنية 

 

 تغيير موضع الصورة  خصائص عنصر الصورة

1 

2 



 

 أعلى المستند

  : لتظهر في الوسط   Centerثم اختر 

  

  :وهذه صورة شاشة من جوّالي 

  

  
  

  

  

        

        

 ...هذا اللوغو الصغير الذي قمت أنا باختياره 

 .انظر إلى  الأزرار قد أصبحوا باللغة العربية 



 

 أعلى المستند

        تعلمّ كيفية ربط عدة فورمز  ببعضهمتعلمّ كيفية ربط عدة فورمز  ببعضهمتعلمّ كيفية ربط عدة فورمز  ببعضهمتعلمّ كيفية ربط عدة فورمز  ببعضهم
  : ينز من خلالهمعلومات النتبواستعراض المزيد من ... للبرنامج  آخر سأقوم الآن بإضافة خيار

  .. وهذا الخيار هو حساب العاملي لعدد ما 

  .                      Flowاذهب إلى نافذة : صنع الواجهة ل) ١

                    Form , okCommand , textField ,stringField          :قم بسحب وإفلات العناصر التالية  )٢

   :  Flow ليصبح لديك الشكل التالي في نافذة

  

  

  

    screenوالشكل التالي في نافذة 

  

    

  

  

  

  

 textFieldقم بسحب وإفلات العنصرين 

,stringField إلى form1 .  

  .  screenوتستطيع سحبهما إلى نافذة 

وبعد تغيير العناوين عن طريق النقر 
 :المزدوج يصبح لدينا الشكل التالي 

ھذه الخانة 
 .;دخال الرقم

ھذه الخانة 
 .;ظھار النتيجة 

 :صائص ثم اضغط زر يمني عليه ثم اختر خ: من أجل منع المستخدم من إدخال أحرف في حقل العدد 



 

 أعلى المستند

  

  

  

  

  : واكتب الدالة التالية   sourceانتقل إلى نافذة  )٣

  

  

  :الكود التالي و قم بإضافة     if (command == okCommand3): ابحث عن ) ٤

  

  

  

  

  

  :زر يمني على خانة العدد ثم اختر خصائص كما في الصورة اضغط : من أجل تحديد عدد خانات الأرقام المسموح بها ) ٥

  

  

  

 .دالة من نوع صحيح وتقوم بإرجاع قيمة صحيحة 

 1 *2 * 3* 4 * 5 = !5:مثلا 

  {إذا ضغط المستخدم زر الموافقة نفّذ 

من النوع  numتعريف المتغير 
الصحيح وإسناد قيمة ما يدخله 

  .المستخدم إليه 

  الرقمي Numericاختر النوع 

أسند الجملة التالية للحقل : إذا كان العدد المدخل أصغر من الصفر 
stringItem1   " واطبع الرقم المدخل، " لا يوجد عاملي للرقم.  

 factأسند قيمة العدد المدخل بعد تمريرها في الدالة : غير ذلك 
! شارة واطبع الرقم المدخل و الإ،   stringItem1إلى الحقل 

  )وذلك من أجل الشكل فقط(

قصى عدد أنا اخترت خانتين فقط أي أن أ
 ٩٩يستطيع أن يكتبه المستخدم هو العدد 



 

 أعلى المستند

   ...في  لوحة المفاتيح  F6الآن اضغط على زر  ) ٦

  

  

  

  

  

  

  

موجودة في  النتيجة وهي باستخدام الجداول وهذه الطريقةبعد أن انتهيت من صنع التطبيق وجدت طريقة أسهل تعطي نفس 
ولم  الإكسلوالعلامات مربكة وغير عملية لذلك أنا لجأت إلى برنامج  الأسماء إضافةون طريقة ربما تك... وما فوق  ٧نسخ البرنامج 

  .شرح وليس فكرة التطبيق بحد ذاتها اللكني أعتقد أن المهم من الكتيب هذا هو ، سوى دقائق قليلة  الأسماء إضافةتستغرق 

        aml_987@hotmail.com: لا تتردد في إرسال ملاحظاتك وتعليقاتك على الايميل 

        ................عودة الاستقرار والأمان إليه عودة الاستقرار والأمان إليه عودة الاستقرار والأمان إليه عودة الاستقرار والأمان إليه ولا تترد في الدعوة لبلدي سوريا لولا تترد في الدعوة لبلدي سوريا لولا تترد في الدعوة لبلدي سوريا لولا تترد في الدعوة لبلدي سوريا ل

  انتهى بعون االله          

 . اضغط على القائمة واختر الخيار الثاني 

 OKاكتب العدد الذي تريده ثم اضغط 


